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1.

A. PENGENALAN MICROSOFT EXCEL & SPSS

Pengenalan Microsoft Excel

Microsoft Excel adalah sebuah program atau aplikasi yang merupakan bagian

dari paket instalasi Microsoft Office, berfungsi untuk mengolah angka menggunakan
spreadsheet yang terdiri dari baris dan kolom untuk mengeksekusi perintah.

Pada tampilan program excel ada beberapa area yang harus dipahami bagi

pemula, agar mengetahui fungsi dan kegunaannya. Elemen-elemen dasar pada
microsoft excel adalah sebagai berikut:

Quick Acces Toolbar, area untuk menampilkan shortcut/cara cepat
menggunakan tool yang sering digunakan, secara default ada tiga tools yaitu
save, undo, redo.

Ribbon, fungsinya untuk mengelompokkan tools ke dalam sebuah menu,
dengan tujuan agar user lebih intuitif dalam menggunakan tool pada excel.
Formula Bar, berfungsi untuk menampilkan, mengedit, menghapus formula
(rumus) yang kita tuliskan dalam cell.

Spreadsheet Grid, area ini adalah lembar kerja utama excel untuk
menambahkan angka, grafik/chart. Area berisi kolom dan baris yang digunakan
sebagai pengalamatan cell, kode kolom menggunakan huruf dari A-Z dan kode
baris menggunakan angka.

Worksheet, secara default dalam satu lembar kerja excel ada tiga worksheet
yang dapat digunakan untuk mengolah data yaitu sheet1, sheet2, sheet3. Jumlah
maksimum yang bisa kita tambahkan adalah 255 worksheet. (Kita dapat
menambahkan menghapus sesuai kebutuhan)

Status Bar adalah bar horizontal yang berfungsi untuk menampilkan informasi
status data excel. Status bar juga menampilkan quick summary dari data yang
kita seleksi (sum, average, min, max, count). Pada samping kanan bawah juga
terdapat slider zoom in dan zoom out untuk mengatur besar kecilnya tampilan
halaman kerja excel.
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Quick Access Toolbar

3

28R
1 e .
ormula Bar ]

G H 1 J K L M N o P Q R s T u -

Spreadsheet Grid

e ' BlE 5 1 .

e Menavigasi Lembar Kerja
TAB - Memindahkan satu sel ke kanan.
SHIFT + Panah Kiri - Memperluas pilihan ke kiri satu sel
SHIFT + Panah Kanan - Memperluas pilihan ke kanan satu sel
SHIFT + Control + Panah Kiri - Memperluas pilihan ke kiri ke sel pertama
SHIFT + Control + Panah Kanan = Memperluas pilihan ke kanan ke sel terakhir
SHIFT+F10 - Menampilkan menu pintasan
Ctrl+Alt Lalu tombol Tab berulang N Jelajahi bentuk terapung, seperti kotak teks
kali atau gambar.

e Bekerja dengan Cell
Ctrl + S - Simpan
Ctrl + C = Menyalin
Ctrl + X - Memotong/Menghapus
Ctrl +V - Menempelkan
Ctrl + Z - Undo
Ctrl +Y - Mengulangi
Ctrl + B - Tebal
Ctrl + | - Miring
Ctrl + U - Garis bawah
Ctrl + A < Memilih semua
Ctrl + F - Temukan
Ctrl +Y - Ulangi
Ctrl + H - Replace/Menggantikan
Ctrl + T = Menyisipkan tabel
Alt + Enter > Menyisipkan hentian baris dalam sel
Delete N Menghapus sel yang dipilih
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2. Pengenalan SPSS

Statistical Package for Social Science (SPSS) merupakan salah satu software atau

program olah data statistik yang populer digunakan dalam mengolah data
riset/penelitian. Pada data sheet SPSS, terdapat dua tab sheet (lembar kerja), yaitu:
Variable view : lembar kerja untuk untuk diisi keterangan variabel

Data view : lembar kerja untuk diisi data yang akan diolah

Tampilan utama SPSS dapat dilihat pada gambar di bawah ini:

Fungsi menu-menu pada Jendela Data Editor di atas:

File untuk membuat file data baru, membuka file data, mengambil data dari
program lain, mencetak isi data, dan lainnya.

Edit untuk memperbaiki atau mengubah data (menduplikasikan, menghapus,
mengedit, dan lainnya).

View untuk mengatur toolbar (status bar, tampilan value label, dan lainnya).
Data untuk melihat perubahan data SPSS secara keseluruhan seperti pengurutan
data, memilih data berdasarkan kriteria tertentu, menggabungkan data, dsb.
Transform untuk membuat perubahan pada variabel yang telah dipilih dengan
kriteria tertentu.

Analyze untuk melakukan semua analisis statistik seperti uji-t, ANOVA, regresi,
dan lainnya.

Graphs untuk membuat berbagai jenis grafik utnutk mendukung analisis statistik
seperti Bar, Line, Pie, Scatter, dan lainnya.

Utilities untuk menu tambahan yang mendukung program SPSS seperti memberi
informasi tentang variabel yang sekarang dikerjakan dan mengatur tampilan
menu-menu lainnya.

Windows untuk berpindah-pindah antar jendela, misalnya dari jendela data editor
ke jendela output viewer.

Help bantuan informasi mengenai program SPSS yang dapat diakses secara
mudah.
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Data Editor SPSS terdiri dari 2 buah Tab Sheet:

1. Variable View

raphs  Utities  Ack Window el

TN =
cHa B 60 =BF A Al B6E %00

| name Type | Width | Decimals|  Label | Values Missing | Columns Align Measure

Tab sheet ini digunakan untuk memberi keterangan variabel.

Berikut ini merupakan gambar lembar kerja (Tab Sheet) Variable View:

Name digunakan untuk menuliskan nama variabel.

Syarat penulisan variabel:

e Nama variabel harus diawali dengan huruf dan untuk selanjutnya boleh
dengan huruf, angka, atau simbol.

e Nama variabel tidak boleh diakhiri dengan tanda titik.

e Panjang nama variabel tidak boleh lebih dari 8 karakter.

e Tidak boleh ada spasi kosong dan tidak boleh menggunakan karakter khusus
seperti tanda !, 7, dan *.

e Tidak boleh ada nama variabel yang sama.

e Tidak boleh menggunakan istilah yang sudah ada pada sistem SPSS (ALL, AND,
BY, EQ, GE, LE, LT, NE, NOT, OR, TO, dan WITH).

Type Digunakan untuk mengisikan tipe data variabel.

Tipe data yang ada dalam SPSS antara lain: String, Numeric, Dot,
Scientific Notation, Date, Dollar, Custom Currency.

Width Digunakan untuk mengisikan panjang maksimal digit data yang
dapat diisikan pada suatu variabel. Adapun panjang digit yang
diijinkan antara 1 — 255 digit.

Decimals | Digunakan untuk mengisikan jumlah angka desimal (angka di
belakang koma).

Label Digunakan untuk mengisikan keterangan dari variabel.
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Value Digunakan untuk mengisikan kode (angka) dari variabel,
biasanya digunakan untuk data nominal (berupa kategori) atau
ordinal (berupa peringkat).

Catatan:
data harus berupa data numeric (angka) agar dapat diproses
oleh SPSS. Dengan demikian, data nominal seperti jenis kelamin,
asal daerah, tingkat pendidikan, dan lainnya harus
dikuantifikasikan (dijadikan angka). Proses pengubahan data
kualitatif (berupa kata atau huruf) menjadi angka tersebut
disebut sebagai CODING (pengkodean).
Contoh kode untuk jenis kelamin:

o 1 =laki—laki

e 2 = perempuan

Missing Kolom tersebut digunakan untuk mengisikan nilai data yang
hilang (kosong), misal pada data yang bersifat skala.

Column Untuk menentukan lebar kolom dalam menampung nilai data.

Align Digunakan untuk menentukan posisi data dalam sel.

Measure | Digunakan untuk mengidentifikasi jenis data yang digunakan.
Terdapat 3 pilihan, yaitu scale (rasio & interval), nominal, dan
ordinal.

2. Data View

]

g lle lolela

Tab sheet data view digunakan untuk mengisikan data pada kolom variabel-
variabel yang sudah didefinisikan sebelumnya. Untuk lebih jelasnya silakan lihat
kembali gambar tampilan utama SPSS data editor di atas. Ada beberapa hal yang
perlu diperhatikan dalam pengisian data pada data editor, yaitu:
a. Kolom, dengan ciri adanya kata var dalam setiap kolomnya. Kolom tersebut

menunjukkan variabel yang digunakan.
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b. Baris, dengan ciri adanya angka 1, 2, 3 dst, menunjukkan jumlah responden
(case number).

c. Sel, merupakan perpotongan antara baris dan kolom sebagai tempat untuk
mengisikan nilai data per aitem, per responden.

Memasukkan Data ke dalam Data Editor

1.

Mengimpor data dari program aplikasi lain.

Data yang akan dimasukkan ke SPSS dapat diambil dari data yang dibuat dengan

program aplikasi lain misalnya excel, dBase, lotus, file teks, dsb. Misalkan kita akan

mengimpor file yang dibuat dengan program aplikasi excel, maka langkah-

langkahnya adalah sbb:

- Klik menu File > Open - Data.

- Maka akan muncul jendela open file-> pilih excel pada kotak File of Type,
kemudian cari nama filenya > klik open.

] Untitied [Datase
file  Edt View Dsta Transform  Analyze Graphs  Utities  Add-ons  Window  Help
=] %9
l Open | = pata Open Da Visible: 0 of 0 Variables
Open Dataase. DR
- = r var var var
Read Text Data |7 oot Look i ‘ Statistika Dasar 2019 '| (=] (“_3? b= A
- | Esem 0
] ez S 7] Data Praktikum Stat. Dasar 2019 xlsx
o 5
Ve e
Recent
L]
[ Rename Dataset i
Display Data Fie informion »
2 cache Data ’J
Documents
550 Switeh Server.
Predictive Enterprise Reposiory »
@— L»l\._ File name: [ Dt Prakiikum Stat. Dasar 2018 xlsx | [ open |
2 Computer | Fiies aftyne: [Excel (s, * s, ") -] [ e | B
Recerily Used Data » o ez 2| comel |
inimize .
g A, sshr o)
e o = [Systat (*:sydl, *5ys) | [ v |
Exit ‘ Re Doptable ]
= [Excel (* xis, * xisx, *xlsm)
oy
2 (Sl ¢*:5lk)
) ldBase (* dhf) ~
24
3 =
KNEd | Db

- Selanjutnya akan muncul jendela opening excel data source.

- Beri centang pada check box read variable, bila menginginkan baris pertama
pada file excel menjadi nama variabel, apabila tidak dicentang maka baris
pertama file excel akan dianggap sebagai data.

- Kotak worksheet, digunakan untuk memilih sheet yang akan ditampilkan.

- Kotak range diisi bila tidak semua data ingin ditampilkan, contoh bila range
diisi A1:B10 berarti data yang diambil hanya berada pada wilayah A1:B10.

- Klik OK.
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&) Untitled3 [DataSet?] - SPSS Data Editor e
Fie Edit Yiew Data Transform  Analyze Graphs  Uities  Add-ons  Window  Help
cHA E o0 LBEF A Ad E0F %09
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I Read vatiable names from the fist row of data

12 werkshest: [ BERPIR POSITIF (1) [41: AE] |
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1: Maximum wricth for string columns: 32787

. -
17
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19
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21
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2. Memasukkan data secara langsung.
a. Mendefinisikan variabel
- Pada jendela data editor, aktifkan tab sheet (lembar kerja) variable view
dengan mengklik tab yang ada di pojok kiri bawah atau dengan menekan
tombol Ctrl T.

- Lakukan pengaturan untuk pendefinisian variabel, contohnya seperti
gambar tabel berikut:

& Nominal
& Scale
& Scale

[ D
.m< .f.....,...... >

- Baris Pertama
Name : Ketik nama, arahkan ke kanan dengan tombol panah ke kolom

type.

Type : Klik tombol kecil yang muncul di kolom. Type pilih String
->characters = 0.

Label  :Nama Mahasiswa

Value :Tidak dilakukan perubahan
Missing : Tidak dilakukan perubahan
Columns : Tidak dilakukan perubahan
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Align : Pilih left (rata kiri)
Measure : Nominal
- Baris Kedua
Name : Ketik JK
Type : Pilih numeric > Width = 1, Decimal Places = 0
Label  :Jenis Kelamin
Value : Klik tombol - tampil jendela value labels - pada kotak value
isikan nilai 1 dan pada kotak value label ketik laki-laki, tekan
enter atau klik add dst.
Bila pemberian kode pada kategori yang ada sudah selesai, klik tombol OK.
B ez st 575 s e

Etit View Dsta Transform  Analyze Grephs  Utities  Add-ons  Window  Help

Fle E Transform ns i
EHE F oo Bk A s SEE Bo%
[ Mame [ Type | widih | Decimals | Label | Values Missing | Columns | Algn | Measure

1 NARA String

Missing : Tidak dilakukan perubahan
Columns : Tidak dilakukan perubahan
Align : Pilih center (rata tengah)
Measure : Nominal

- Baris Ketiga
Name : Ketik IPK
Type : Pilih numeric
Label  :Indeks Prestasi Kumulatif
Value  :Tidak dilakukan perubahan
Missing : Tidak dilakukan perubahan
Columns : Tidak dilakukan perubahan
Align : Pilih center (rata tengah)

Measure : Scale
b. Memasukkan (entry) data

- Aktifkan lembar kerja data view dengan menekan tombol Ctrl T atau klik
tab sheet data view pada pojok kiri bawah.

- Masukkan data-data yang ada pada kolom-kolom variabel yang sudah
didefinisikan sebelumnya. Untuk pindah ke sel yang lain gunakan tombol
panah.

- Pada kolom variabel JK data-data yang diinputkan cukup dengan
mengetikkan kode nilai yang sudah didefinisikan sebelumnya, maka
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secara otomatis kode nilai akan diganti dengan value labelnya. Apabila
value labelnya belum muncul cobalah aktifkan dengan mengeklik menu

view > pilih value labels.

B “Untitied? [Dat

File Edit | View Dsta Iransform  Analyze  Graphs Ufiiss  Addons  Window  Help
=H & v stetvs o EdhEH EBEeo®
10: Toolars »
ol | 1Pk | var var var

1 Fonts | 320

2 ¥ Grid Lines | 3.34

3 | l@ “alue Labels IF 3.36

4 = M 30

B =

B E “ariahles CHrl-T

7 I

B0 €8 Vew (i Dwwkm Loi> Gwie Usien Mdbwm Bhiow toh
CUA W 60 LEl A b S0E B

[ K [

Ahmad LAK-LAKI n
2 |k LAK-LAKI EE!]
3 |Siska PEREMPUAN 1%
4 P PEREMPUAN im
Data wiew | Vel e

- Untuk pengisian data pada variabel IPK, tanda koma diketik dengan tand

a

koma, bila pada komputer yang digunakan tidak bisa dengan tanda koma,
maka diperlukan pengaturan pada regional setting dan bila hal tersebut

belum bisa, maka bisa kita ganti dengan tanda titik.

Menyimpan Data
- Untuk menyimpan file data yang baru, klik menu file - save as.

o % Wew [ Junsiom frehms Grgbs e Addges edow ek

- Vim EeE @e%
oon
o D
Fea Ted Duta. Save it | STATISTIK " ] ﬁﬁ L
5 corn e
= an
T
Save s ] =ik
e 7
2 coeton Recent
TR "
Dfsplary Data Fie Informagon L4
thy Cocts o Deskiop
[
xS Ser
e ' L‘L Kesping 3 of 3 varisbles ‘ Veraes |
[ Pt presew Dacuments  File name: Data Praktivum 2019
s e | sae |
P—— N Save &s type |\spss tsav) \ | e ]
Recentty Used e +
= [ canca |
: [ nee |
L | store File To Predictive Enterprise Repositary... |
; v

DataView  Verisbie View

- Pada kotak isian file name, isikan nama file dan simpan dengan ekstensi *.sav

10
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Mengedit atau mengubabh isi data

Pilih sel yang akan diganti atau diubah isi datanya, klik 2 kali lalu ketikkan data
yang baru kemudian tekan enter atau cukup dengan pindah ke sel lain dengan tombol
panah. Kemudian tekan tombol save bila menginginkan perubahan data disimpan.

Menghapus data

- Untuk menghapus data dalam sel, pilih sel yang akan dihapus datanya, klik tombol
delete.

- Untuk menghapus data beberapa sel, blok sel-sel yang akan dihapus datanya,
tekan tombol delete.

- Untuk menghapus isi data satu kolom maka klik judul kolom (nama variabel) yang
akan dihapus, kemudian tekan tombol delete atau bisa juga dengan klik kanan
pada judul kolom, pilih clear.

- Untuk menghapus isi data satu baris atau satu case, klik nomor case yang akan
dihapus, klik tombol delete atau klik kanan nomor casenya lalu pilih clear.

Mengkopi data
Untuk mengkopi isi sel > pilih sel yang akan dikopi, tekan tombol Ctrl C,
kemudian pindahkan kursor ke sel yang dituju lalu tekan tombol Ctrl V.

Mengubah nama variabel
Pada lembar kerja variable view, klik 2 kali nama variabel yang akan dihapus,
ketikkan dengan nama baru.

Menghapus variabel

- Aktifkan tab sheet variable view dengan menekan tombol Ctrl T.

- Pilih variabel yang akan dihapus dengan klik nomor variabel.

- Tekan tombol delete atau bisa juga dengan klik kanan nomor variabelnya, lalu pilih
clear.

Menyisipkan kolom (variabel) dan baris (case)

- Untuk menyisipkan suatu kolom (variabel) bila dilakukan dari tab sheet data view,
misalkan kita akan menyisipkan kolom pada urutan ke-2, maka klik kanan pada
kolom ke 2, kemudian pilih insert variabel.

Apabila dilakukan dari tab sheet variable view, klik kanan nomor variabelnya,
kemudian pilih insert variabel.

- Untuk menyisipkan suatu baris (case), aktifkan terlebih dahulu tab sheet data view,
klik kanan kemudian pilih insert case.

11
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Mengurutkan data

Pengurutan dapat dilakukan dengan perintah shortcases. Adapun langkah-

langkahnya adalah sbb:

1.

2
3.
4

Buka file yang akan diurutkan.

. Pilih menu data = shortcases.

Pindahkan satu atau beberapa variabel yang akan digunakan sebagai kunci.

. Pilih modus pengurutannya, ascending (urutan naik, dari nilai yang kecil ke nilai

yang besar) atau descending (urutan turun).
Klik OK.

Transpose data

Transformasi (transpose) data adalah memindahkan kolom data menjadi baris

dan juga sebaliknya memindahkan baris menjadi kolom. Langkah-langkah untuk
transpose data adalah sbb:

1.
2.
3.

4.

Buka file yang akan ditranspose.

Pilih menu data - transpose.

Pindahkan satu atau beberapa variabel ke kotak variabel bila hendak
mengubahnya menjadi baris dan pindahkan salah satu variabel lagi ke kotak name
variabel bila hendak menjadikan datanya menjadi kolom. Apabila ada variabel
yang tidak dimasukkan ke kotak variabel name, maka variabel dan datanya akan
hilang.

Klik OK.

Short Key dan Fungsinya:
CtriCc > Untuk mengkopi data
CtriX > Untuk memotong suatu data dengan tujuan untuk memindahkannya ke

tempat / posisi lain.

Ctriv > Untuk meletakkan data / file yang dikopi atau dipotong

Ctrliz > Untuk membatalkan perubahan yang dilakukan selanjutnya

CtrlA-> Untuk memblok semua data yang ada di lembar kerja

CtriT > Untuk berpindah dari tab sheet data view ke tab sheet variable view, atau

sebaliknya.

12
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TEORI POKOK
1. Fungsi Statistik Sebagai Deskripsi

Berfungsi untuk memberikan informasi yang bersifat deskriptif terhadap data
yang ada. Data deskriptif dapat berupa tabel maupun diagram. Data deskriptif statistik
antara lain jumlah subjek (N), nilai minimal, nilai maksimal, mean (rerata), median,
modus, dan standard deviation (SD). Selain itu, juga dapat menyajikan data dalam
bentuk tabel frekuensi dan persentase.

a. Penyajian Deskripsi Statistik
Berikut akan dijelaskan cara penyajian data deskriptif statistik dari suatu data
dan langkah-langkah yang dilakukan melalui SPSS. Data penelitian 1:

Variabel X1 : Jenis Kelamin
Variabel X2 : Konformitas
Variabel Y : Kemampuan Negosiasi

Tabel 1. Data Penelitian 1

No. X1 X2 Y
1 Laki-laki 5 8
2 Laki-laki 4 5
3 Laki-laki 6 8
4 Laki-laki 5 7
5 Laki-laki 6 8
6 Laki-laki 4 6
7 Laki-laki 3 6
8 Laki-laki 4 5
9 Laki-laki 5 6
10 Laki-laki 6 7
11 Laki-laki 7 3
12 Laki-laki 8 3
13 Laki-laki 9 2
14 Laki-laki 8 1
15 Laki-laki 7 2
16 Perempuan 6 2
17 Perempuan 5 1
18 Perempuan 4 1
19 Perempuan 3 1
20 Perempuan 4 2
21 Perempuan 5 5
22 Perempuan 6 2
23 Perempuan 5 4
24 Perempuan 4 3
25 Perempuan 6 3

13



Panduan Praktikum Statistika Dasar
Fakultas Psikologi UAD

26 Perempuan 7 2
27 Perempuan 8 2
28 Perempuan 9 1
29 Perempuan 8 3
30 Perempuan 7 2

b. Langkah membuat penyajian data:
1. Buka program SPSS.
2. Masukkan keterangan variabel data penelitian 1 dalam variable view.
3. Tuliskan pada kolom Name variabel X1, X2, Y.

file Edt ¥iew Dala Iransform  Analyze Grephs  LUities Addons  Window  Help

=Ha B ek A Ah BEhE Y09
Mame Type ‘ Width | Decimal Isl Label | Walues Missin q Columns Align | Measure
1 Esl Murneric &) o JENIS KELAMIN 1, LAKI-LAKI} Mone g = Right &> Mominal
w2 MNumeric 8 0 KONFORMITAS Mone Mone g = Right & Scale
uuuuuu 8 0 KEMAMPUAN NEGOSIAS] MNone Mone 8 = Right & Scale

(LN TS OV N
-
=

4. Type secara otomatis akan tertulis numeric, hal ini menunjukkan data yang
dimasukkan berupa angka.

5. Width secara default tertulis 8, hal ini menunjukkan angka yang dimasukkan
pada data maksimal 8 digit.

6. Decimal secara default tertulis 2, jika data yang dimasukkan tidak
mengandung nilai desimal maka dapat dituliskan O (nol).

7. Label merupakan kolom variabel yang dapat dituliskan nama variabel secara
lengkap sesuai dengan variabel penelitian yang ada yaitu X1 (jenis kelamin),
X2 (konformitas), dan Y (kemampuan negosiasi).

8. Pada kolom values diisi jika data penelitian berupa nominal, yaitu angka
yang berfungsi untuk memberikan label pada variabel. Dalam contoh data
penelitian 1, variabel yang bersifat nominal adalah jenis kelamin, sehingga di
kolom values perlu dituliskan 1 untuk laki-laki dan 2 untuk wanita.

9. Align adalah posisi angka yang dimasukkan dapat dipilih center (tengah), left
(rata kiri), atau right (rata kanan).

10. Measure merupakan kolom yang harus dipilih sesuai dengan data penelitian
apakah bersifat nominal, ordinal, atau scale.

11. Buka menu data view dan masukkan data sesuai dengan data penelitian 1.
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File Edit iew Data Iransform  Analyze  Graphs  Utities  Add-ons

Window  Help

2da B o0

mEE A ES

=1 oz ®

[ |

[ a ]

| ¥

o
TP R U PO P O Y

M~ 0@ W O & W & @@ &

4

Data View | “ariable Yiew

12. Setelah data lengkap dalam data view, klik analyze > descriptive statistic

- descriptive.

file Edt View Date Transform | Anelyze Graphs  Uifies Addons  Window  Help

EHA § 6 =E|

13. Masukkan variabel yang akan dianalisis

kemudian klik OK.

file Edt ¥ew Dsta Iransform

Reports
Descriptive Statistics
Taigles

Compare Mesns

General Linzar Mode!
Generalized Linear hadels
Mixed Models

Correlate

Regression

Logiinear

eLral Netyvorks

Classify

Deta Recluction

Seale

Monparametric Tests

Time Series

Znelyze  Graphs  Utities  Add-gns

¥ | 123 Frequencies
| Py pescriptives
* | B Explore

v |0 grosstahe
¥ | 2] Ratio

b | [ pop plots
» | [ 0ops

Window  Help

EHaE E o0 2k & A ExcE Eoe

x| e | ¥

B Descriptives

[[] save standardiged values as variables

[ ox

(e J[eent [ conen o

MM~ 0o~ 00 eWRSDOH® RO

o
[T P O U PO U O P Y

ke dalam kolom Variabel (s)
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14. Lihat output.

Descriptives
[DataSetl]
Descriptive Statistics

I flinimurmn | Maximum flean Std. Deviation
1 a0 1 2 1.80 A0g
L 30 3 ] 5.80 1.710
¥ a0 1 ] 3.70 2341
Yalid M {listwise) a0

15. Cara membaca hasil statistik deskriptif:

16.

17.

Kolom N menunjukkan jumlah subjek yang diteliti adalah 30 orang
Kolom minimum menunjukkan skor minimum masing-masing variabel.
Variabel jenis kelamin = 1, variabel konformitas = 3, dan variabel
kemampuan negosiasi = 1.

Kolom maksimum menunjukkan skor maksimum masing-masing
variabel. Variabel jenis kelamin = 2, variabel konformitas = 9, dan variabel
kemampuan negosiasi = 8.

Kolom mean menunjukkan nilai rerata masing-masing variabel. Rerata
variabel jenis kelamin tidak perlu diartikan karena berupa data nominal,
rerata variabel konformitas = 5,80 dan rerata variabel kemampuan
negosiasi = 3,70.

Kolom Std. Deviation menunjukkan standard deviation atau simpang
baku dari masing-masing variabel. SD jenis kelamin tidak perlu diartikan
karena berupa data nominal, SD variabel konformitas = 1,710 dan SD
variabel kemampuan negosiasi = 2,351.

Langkah untuk membuat tabel frekuensi dan persentase yaitu klik analyze
- descriptive statistic > frequencies.

Masukkan variabel yang akan dianalisis pada kolom Variabel (s), kemudian
klik OK.

file Edt ¥ew Dsta Iransform

=HE & ©

Anelyze  CGraphs Utities Addpns  Wndow  Help

Eo o]

o &

Regorts »

il

Descriptive Statistics 123 Frequencies

Tables [Py Descriptives

I

B Explore.
E Crosstabs...

Compare Means

General Linear Mode|

[z Ratio

Generalized Linear Models

[ p-pPiots...

Mized Modets

Correlate [ @-a Pits...

Recression

FEf] Frequencies

Nevral Networks:

(= N =, B S R P

Classity Nariable(s):

g

T Data Reduction

Scale

1

12 Monpsrametric Tests

»
»

»

»

3

»

»

3

Loglinesr »
»

3

»

»

»

Time Serisx 3
»

13

Survival

14

15 Missing Velug Anslysis...

16 Multipls Responss 3

Complex Samples 3
17 Display frequency tables

-
[ N O U PO O O T Y

Quality Cortrol »

Data View

[ roc curve. = ‘ OK H Paste || Reset || Cancel || Help

W ariable View
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18. Lihat pada hasil (output) yang akan memberikan data tentang masing-

masing variabel meliputi frekuensi, persentase, persentase yang valid, dan
persentase kumulatif.

Frequencies
[Dataletl]
Statistics
4| W i
M Walid an a0 30
Missing 1] 1] ]
Frequency
X1
Curmulative
Freguency Fercent | “alid Percent Fercent
Valid 1 14 a0.0 a0.0 a0.0
2 14 a0.0 a0.0 100.0
Total a0 100.0 100.0
w2
Cumulative
Freguency Fercent | “alid Percent Percent
Walid 3 2 6.7 6.7 6.7
4 f 20.0 200 26,7
5 B 200 200 46.7
B f 20.0 200 BE.T
7 4 13.3 13.3 a0.0
S 4 13.3 13.3 933
8 2 6.7 6.7 1000
Total a0 100.1 100.0
Y
Cumulative
Freguency Percent Yalid Fercent Fercent
Walid 1 g 16.7 16.7 16.7
2 a 268.7 26,7 433
3 g 16.7 16.7 0.0
4 1 3.3 33 3.3
5 3 10.0 10.0 733
B 3 10.0 10.0 833
7 2 6.7 6.7 S90.0
g 3 10.0 10.0 100.0
Tatal 30 100.0 100.0
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2. Fungsi Statistik sebagai Inferensial

Berfungsi untuk menganalisis data dalam rangka menguji hipotesis yang
diajukan dalam penelitian (menggunakan statistik parametrik maupun non
parametrik). Pemilihan teknik analisis statistik untuk menguji hipotesis disesuaikan
dengan tujuan penelitian: perbedaan (komparasi) atau hubungan (korelasional).

Sebelum dilakukan uji hipotesis, beberapa ahli menyarankan uji asumsi yang
bertujuan untuk memastikan terpenuhinya asumsi dalam penelitian. Uji asumsi
meliputi uji normalitas, homogenitas, dan linieritas. Berikut rangkuman teknik
analisis statistik inferensial.

Tabel 2. Rangkuman Teknik Analisis Statistik

Statistik Parametrik Statistik Non Parametrik
Studi/Peneliti i
udi/Penelitian Tekl?".( Uji Asumsi Teknik Analisis Uji Asumsi
Analisis

Independent | - Normalitas

sample t-test | - Homogenitas Mann Whitney U | Homogenitas

Komparatif
(perbedaan) Paired sample .
+-tost Normalitas Wilcoxon -
Product ,
Korelasional moment - Normalitas Spearma/? s Rho -
(hubungan) (Pearson - Linieritas (Korelasi Tata

correlation) Jenjang)

Membaca hasil uji signifikansi (p) berkaitan dengan hipotesis penelitian (berarah — tidak
berarah)

e hipotesis berarah - p=1 ekor (one tailed)

e hipotesis tidak berarah > p=2 ekor (two tailed)

3. Uji Asumsi

zMllUji Normalitas

e Digunakan untuk teknik analisis statistik parametrik, uji beda (komparatif)
maupun uji hubungan (korelasional)

Hanya untuk variabel yang memiliki data berupa skor (data rasio/interval)
Tujuan: untuk menguji hipotesis nihil (Ho) “tidak ada perbedaan sebaran
data antara sampel dan populasinya”

e Kaidah uji signifikansi: p > 0,05. Tidak ada perbedaan sebaran data antara
sampel dan populasinya. Sebaran skor sampel membentuk kurva normal
(data pada sampel memiliki sebaran normal), sama seperti estimasi sebaran
skor pada populasi.
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Langkah analisis:

a. Block semua skor total > masukkan ke dalam data view SPSS

b. Click Analyze > Nonparametric Tests > One Sample K-S (Kolmogorov
— Smirnov)

¢. Block variabel yang hendak diuji di kotak kiri (kotak data), pindahkan ke
kotak sebelah kanan (kotak analisis).

d. Click options >check list (\) Descriptives

e. Interpretasi: di dalam tabel One Sample Kolmogorov-Smirnov Test
—>Kolmogorov-Smirnov Z (K-S Z)= indeks normalitas dan asymp. Sig. =
taraf signifikansinya (=p).
e Asymp.Sig (taraf signifikansi/p) > 0,05: sebaran data normal
o Asymp.Sig (taraf signifikansi/p) < 0,05: sebaran data tidak normal
¢ Contoh sebaran data normal:

Histogram

Mean =687
Stdl. Dev. =1 .565
M=31

Frequency

1 N

T T T T
4 6 8 10

B Uiji Linieritas

e Diaplikasikan pada studi korelasional antara 2 variabel untuk statistik
parametrik maupun non-parametrik

e Tujuan: untuk memastikan bahwa data kedua variabel yang akan
dikorelasikan dapat dihubungkan dengan garis lurus (linier)

e Kaidah uji signifikansi: p (Fiinearity) < 0,05 dan p (deviation from linearity)
> 0,05

Langkah analisis:

a. block skor total masing-masing variabel > masukkan ke dalam data view
SPSS

b. click Analyze > Compare Means -> Means
e masukkan variabel tergantung ke kotak (Y)  : dependent list
e masukkan variabel bebas ke kotak (X) : independent list

c. check list (\) Test for Linearity
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C.

d. interpretasi:
lihat Anova Table - di dalam kolom pertama: lihat between group - baca

linearity dan deviation from linearity -> kolom F menunjukkan indeks

linearity & kolom sig. menunjukkan taraf signifikansi (=p).

e Sig. Fiinearity<0,05 dan Sig. Fpeviation from Linearity>0,05: Variabel Bebas (X)
linier dengan Variabel Tergantung (Y)

e Sig. Fiinearity >0,05 dan Sig. Fpeviation from Linearity>0,05: Variabel Bebas (X)
linier dengan Variabel Tergantung (Y), tetapi linieritas kurang ideal.

¢ Contoh linieritas:

Uji Homogenitas
e Diaplikasikan pada studi komparatif (uji perbedaan) untuk statistik

parametrik maupun non-parametrik yang memiliki rancangan faktorial.
Variabel tergantung: data interval; variabel bebas: data nominal
Tujuan: untuk memastikan bahwa kedua kelompok subjek yang akan
dikomparasikan memiliki variansi skor yang setara (homogen).

e Kaidah uji signifikansi: p (Levene statistic) > 0,05 - tidak ada perbedaan
variansi skor antara dua kelompok subjek yang akan diperbandingkan atau
diuji perbedaannya.

Langkah analisis:

a.
b.
C.

block data variabel bebas - masukkan ke dalam data view SPSS
block skor total variabel tergantung = masukkan ke dalam data view SPSS
click Analyze > Compare Means -> One Way Anova
e masukkan data variabel tergantung ke kotak : dependent list
e masukkan data variabel bebas ke kotak : factor
click options = check list (v) homogeneity of variance test
click continue =2 click OK
interpretasi-> lihat tabel Test of Homogeneity of Variances:
e Levene statistic menunjukkan indeks homogenitas.
e sig. menunjukkan taraf signifikansinya (= p).
- sig. (p) > 0,05: Data kedua kelompok, homogen.
- sig. (p) < 0,05: Data kedua kelompok, tidak homogen.
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PERTEMUAN 1

1. KORELASI PRODUCT MOMENT (Statistik Parametrik)
Untuk menguji hubungan antara 1 variabel bebas (data: rasio/interval) dengan
1 variabel tergantung (data: rasio/interval).
Korelasi/hubungan mempunyai 2 arah yaitu positif dan negatif:
a. Hubungan positif, artinya semakin tinggi X maka semakin tinggi Y dan sebaliknya
semakin rendah X maka semakin rendah Y
b. Hubungan negatif, artinya semakin tinggi X maka semakin rendah Y dan
sebaliknya semakin rendah X maka semakin tinggi Y.

Hipotesis korelasional ada 2 tipe yaitu berarah dan tidak berarah:

a. Hipotesis berarah sudah menunjukkan arah hubungan positif atau negatif.
Contoh hipotesis berarah: ada hubungan positif antara minat membaca dengan
prestasi belajar pada mahasiswa, semakin tinggi minat baca maka semakin tinggi
prestasi belajar. Penelitian ini menunjukkan variabel tergantung adalah prestasi
belajar dan variabel bebas adalah minat membaca.

b. Hipotesis tidak berarah hanya menyebutkan adanya hubungan.

Contoh hipotesis tidak berarah: ada hubungan antara minat membaca dengan
prestasi belajar pada mahasiswa.

Teknik korelasi product moment dari Pearson diawali dengan dua uji asumsi
yaitu uji normalitas dan uji linieritas. Berikut ini adalah contoh data penelitian 2:
Variabel tergantung (Y)  : Prestasi Belajar
Variabel bebas (X) : Kedisiplinan Kuliah

Tabel 3. Data Penelitian 2
No X

OO || A|[J|OY|(00 |00 (N (U<

O|IN([N[ooINLnw| WO |N|O |

— | — | — | — | —) [
e i bvel e e = KR K= RN R [ N [T, N NS VURT ) B
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No

16

17

18

19

20

21

22

23

24

25

26

27

28

29

30

31

Nojo|Nojw|M|IMlnjn|joo ||| | |00 X

O|N|o|o|N [l || |N|W |0 |[W|=<

Langkah analisis korelasi Product Moment :

a. Klik variable view beri nama variabel sesuai dengan variabel penelitian

Eil=  Edit iew Dsta Transform  Analyze  Graphs  LHiitiss  fSdd-ons  Window  Help

=edS B oo

i 4 A =RE W o W

Mame | Type | width [ Decimals | Label | wales Missing Align | tMeasure
1 edisiplinan  Furneric o Kedisiplinan Kuliah MNone Mons = Right [<¥ Scale -
= Prestasi Murneric o Prestasi Belajar  Mone Mone E] = Right & Scale
3
4
i=)
=]
.
b. Masukkan ke dalam data view
13 7 =]
14 7 9
Eile Edit Wiew Deta Iransform  Analyze Graphs  Ufilties 15 g =]
=H&E | e EHE d EE B 16 a g
1 : Kedisiplinan 4
17 7 g
| X 1an Prestasi | war | war
] ) 5 18 g a
2 & 7 19 5] 7
3 7 g
7 s = 20 5 &
5 g 5 21 g a
8 a 7 22 5 &
7 3 4
B 4 5 23 5 5]
] 3 4 24 4 5
1o 5 & s A =
1 7 g =]
= 5 g Data Wi “ariahle Vi
13 F2 s a wiew ari@ble Views

c. Lakukan uji normalitas dan linieritas.

Uji Normalitas : Analyze - Nonparametric Tests > 1-Sample K-S, akan

muncul tampilan seperti ini :
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File Edit “iew Data Transform | Analyze Graphs  Uilties Add-ons  Window  Help
=Hd i e nE{ Reports » &Qr‘l -
|3 : | Desscriptive Statistics » E Cne-Sample Kelmogorov-Smimov Test ﬁ
— e
kedisiplinan.kuliah| pre Tagles g Ir_ I e BT Ject varidble L Exact...
1 4 Compare Means b 3 Ontions..
2 I General Linear Maocel (]
3 7 Generalized Linear Models ]
4 ] Mixed Models 3
5 g Correlate »
B 5 Regression ]
7 3 Loglinear » Test Distribution
g 4 Meural Metworks » Mormsl ] Uniform
5 3 Classify » [IPoiszon  [] Exponential
10 5 Data Reduction 4 [ o [ esste ][ meset |[ concel |[ hen |
11 7 Scale L2 I ¢
12 a Monparametric Tests » El Chi-Souare...
13 7 Titme Series b Binomial...
14 7 Survival (] Runs...
15 a Miz=zing Value Analysiz... @ 1-Sample K-5..
16 ] Multiple Response > | A 2 Independert Samples...
17 7 Complex Samples » K Independent Samples...
18 a Guality Control b 2 Relsted Samples. ..
19 I3 ROC Curve... m K Related Samples...
20 =3 B

Pindahkan “kedisiplinan.kuliah” dan

“prestasi.belajar” dari kolom kiri ke kanan,

dengan cara klik "kedisiplinan.kuliah” dan “prestasi.belajar” lalu klik tanda “anak
panah ke arah kanan”, sehingga muncul seperti berikut:

File  Ecit

Wiew

Data  Transform

Analyze  Graphs

LKilties

Add-ons  Window  Help

cHE B 00 80 4 g E6E 909

|20

kedisiplinan. kuliah| prestasi..belajar|

war

war | war |

War

war

war | war

1

LU I I ¥ w5 T =P W I L )

-~ 0 0 YD MW e WM m 0 m

5

.
@ One-Sample Kelmogorov-Smirnov Test

S5

Test Yariable List:

& kedisiplinan kulish

lf prestasi. belsjar

| COptions

—

rTest Distri

Mormal I
|:| Pois=on I:l Exponential

[T unitarm

[ ok

I[ Paste ” Reset ” Cancel ” Help

{mu B W R ¥ R U N N s 7 B n Ry n R |

Pastikan bahwa kotak di samping tulisan Normal sudah di “klik” sehingga
muncul tanda (V). Klik OK, akan muncul hasil sebagai berikut:
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NPar Tests
[Dataletd]
One-Sample Kolmogorov-Smirnov Test
kedisiplinan. prestasi.
kuliah helajar
M H a |
Marmal Parameters® hean 597 6.87
Std. Deviation 1.663 1.565
Maost Extreme Differences  Absolute 184 2B
Fositive A1 10
MHegative -184 -216
kalmagoroy-Smirnoy £ 1.026 1.204
Asymip. Sig. (2-tailed) 243 A10

a. Test distribution is Marmal.

Uji Linieritas: Klik Analyze > Compare Means -> Means
] -Untitled1 [DatsSet0] - SPSS Data Editor N

File Eclit  “iew Data Transform Analyze Graphs Liilties  Add-ons Winclowy Help
= H El' - ESWE-E Reports %':}-Eﬁ @

20: De=criptive Statistics

Tables

kedisiplinan.kuliahl fre
4 Compare Means

-
M Means...

T One-Sample T Test..

e Independent-Samples T Test...

General Linear Model

Generalized Linear Models

Mized Models

n,!n2 Paired-Zamples T Test...
. Cnetway AMOWA. .

Correlate

Eegression

Loglinesr

Meural Metworks

Classify

DD~ |0 |& W[k =

Diata Reduction

—
]

Scale

—_
—_

* w T ¥ ¥ ¥ ¥ ¥ w¥ W ¥ ¥ ¥ Ww ¥w

o~ M W e W moo~m

Monparametric Tests

12

Pindahkan prestasi belajar (variabel tergantung) pada kotak dependent list,
dengan cara blok “prestasi belajar” dan klik anak panah di samping kotak
dependent list.

Pindahkan kedisiplinan kuliah (variabel bebas) pada kotak independent list,
dengan cara blok "kedisiplinan kuliah” dan klik anak panah di samping kotak
independent list.
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Eile Edit “iew Data Transform  Analyze  Graphs  Uilties  Add-ons  Window  Help

CHE F o0 Lk & A8 BLE 00|

20:
kedisiplinan kuliah| prestasi _belajar| war ‘ var war | war war war | war |
1 4 3
2 B 7
3 7 8 Q Means Iér
4 8 g
5 g g z}aendem List: |W|
5 5 7 - prestasi. belajar -
7 3 4
8 4 5 Layer 1 of 1
9 3 4 [ hed |
10 8 B
11 7 g
12 8 g
13 7 g
14 7 E | [a]4 J| Paste H Reszet || Cancel H Help |
15 3 9 L
16 8

9
Klik option - berikan tanda cek () pada Test for linearity di pojok kiri bawah >
continue > OK

File Edt View Dsta Iransform Analyze Graphs  Utities Addons  Window  Help

CHE T b =Bk & At BEE S0

20
B Means: Options ==
ked\swplman.kuhahl prestasi. be\ajar‘ var var L
1 4 5 Statistics Cell Statistics:
2 b ’ ZEdIEndM &l b :EEI; f C
rouped Median umber of Cases
3 7 8 B8 Meaq | |ste. Error of Mean Standard Deviation =S
4 g g Sum
5 B 3 MirimLm l\prs... J
5 5 7 Maximum
Range J—
¢ 3 4 First | - ‘
8 4 5 Last —
) 3 4 Wariance
10 5 g Kurtasis
It E ) Stdl. Errar of Kurtosis
Skewness
iz 8 8 Stdl. Error of Skewness
13 7 8 Harmaric: Wean I~
14 7 ° Statistics for First Layer
15 g 9 p |
15 8 E - - |
17 7 g
18 3 9 |_cortie || cancel || hem
19 B 7
20 i 5}
— 1 - -
AMOWA Table
Surm of
Sguares of Mean Square F Sig
prestasi. belajar* Between Groups 59.312 a 13 862 23.080 ooo
kedisiplinan.kuliah Linearity ) BT.564 1 BT7.564 404.923 ooo
Deviation frorm Linearity 1.748 4 AZT 2.619 053
Within Groups 4171 245 167
Total 73.424 20

Pada kasus di atas, FLinearity = 404,923 ; p = 0,000 (p < 0,05)
FDeviation from Linearity =2,619; p = 0,059 (p > 0,05)

Interpretasi:

-

\

Variabel Bebas linier dengan Variabel Tergantung, karena:
S|g FLinearity<0105 dan Slg l:Deviation from Linearity>0105

- Jika salah satu kriteria tidak terpenuhi, data masih dapat dikatakan linier
tetapi kurang ideal.
- Data tidak linier jika keduanya tidak terpenuhi - sig. pada baris linearity
\ p>0,05 dan sig. pada deviation from linearity p<0,05 /
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d. Jika lolos uji asumsi maka dapat menggunakan teknik korelasi product moment.
e. Klik analyze > correlate - bivariate

File  Edit iew Data Transform | Analyze  Graphs  Uiities  Add-ons  Window  Help
= Hd s O E;WE-E Reports » @;’_‘1
5 Kediziplinan ] Descriptive Statistics L3
Kedisiplinan Prest =S ' war | war war WA

1 4 Compare Means 13

E 53 Genetal Linear Model L3

3 7 Generalized Linear Models P

4 g Mixed Models 3

5 B Correlate b | B Bivariate...

6 5 Regression b (Teo Partial...

7 3 Loglingar » | & Distances..

g 4 Meural Metworks 3

g 3 Classify 3

10 5 Data Reduction 13

11 7 Scale L3

12 g Monparametric Tests 3

13 7 Titme Series 3

14 7 Survival 13

15 a Missing value Analysis...

15 g Multiple Responze 3

17 7 Complex Samples 13

18 a Quality Cortrol 13

19 B ROC Curye. .

20 =1 B

f. Masukkan variabel yang akan dikorelasikan ke kolom Variable > pilih Two Tailed
jika hipotesis tidak berarah dan pilih One Tailed jika hipotesis berarah = klik OK

Ele  Edt Mew Data Iransform  Analyze  Graphs  Utitiss  Add-ons  Wndow  Help

EHE B o0 LE[EF A EH SEE %0
2 Kedisiplinan B
Kedisiplinar | Prestasi | var | var | war | var var var var var | war | w
1 4 9
2 B 7
3 7 A i Bivariate Correlations EH|
4 8 8 . —
a B 6B e linan Kuliah [Ked ‘ Ctians ‘
= . E [ Prestasi Beljar [Prestasi]
7 3 4
8 4 5 |T‘
El 3 4 L
10 ] B
" 7 8
12 8 g
13 7 ] Correlation Coefficients:
14 7 g [¥]Pearson [ Kencalls taub [] Spearman
15 8 E Test of Significance
16 8 a - -~
(o) Twwotailed () One-tailed
17 7 8
18 g g Flag significant correlations
19 B 7
- 5 5 [_or || easte || meset |[ cancel |[ nem
21 8 g
22 5 G
g. Output.
Correlations
Kedisiplinan
Kuliah Prestasi Belajar
Kedisiplinan Kuliah Pearson Correlation 1 959
Sig. (2-tailed) C.000)
N 31 31
Prestasi Belajar Pearson Correlation .959 1
Sig. (2-tailed) .00o0
N 31 31

**. Correlation is significant at the 0.01 level (2-tailed).
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h.

Interpretasi:
» Lihat table correlations > Pearson Correlation menunjukkan koefisien

korelasi antara dua variabel yang diteliti; sig. (2-tailed) menunjukkan taraf
signifikansi (p).

» Hipotesis dinyatakan diterima jika p < 0,05 dan ditolak jika p > 0,05.
Untuk mengetahui sumbangan variabel bebas terhadap variabel tergantung
dapat dilakukan dengan cara = mengkuadratkan koefisien korelasi (=koefisien

determinan), kemudian dikalikan 100%. Dalam kasus ini, maka besarnya

sumbangan kedisiplinan kuliah terhadap prestasi belajar adalah sebesar

(0,959)% x 100% = 91,9%.

2. KORELASI SPEARMAN'’S RHO (Statistik Non Parametrik)

Untuk menguji hubungan antara 1 variabel bebas (data: ordinal) dengan 1

variabel tergantung (data: ordinal).

Contoh hipotesis: ada hubungan antara ranking semester 1 dengan ranking
semester 2. Penelitian ini menunjukkan variabel bebasnya adalah rangking

semester 1 dan variabel tergantungnya adalah rangking semester 2.
Berikut ini adalah data penelitian 3:

- Variabel bebas : ranking semester 1

- Variabel tergantung : ranking semester 2

Tabel 4. Data Penelitian 3

Subjek Ranking Ranking
Semester 1 Semester 2
A 1 2
B 2 1
C 3 4
D 4 5
E 5 3
F 6 8
G 7 6
H 8 7
I 9 10
J 10 9

Langkah analisis korelasi Spearman’s Rho:
a. Klik variable view - beri nama variabel sesuai dengan variabel penelitian.

*Untitled3

File  Edt “iew Data  Transfortm  Analyze  Graphs  Uilties  Add-ons Window Help

cHE F 00 =RE # g S0E BO%

MName | Type | Width |Dec|ma\5‘ Label “alues | Migsing | CUIumns‘ Align | Measure

1 Rank_Sem1  Mumeric g8 u] Rangking semester 1 MNone Maone Right ol Ordinal
2 Rank_Sem2  Mumeric g8 u] Rangking semester 2 MNone Maone 8 = Right £l Ordinal
8
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b. Masukkan ke dalam data view

File  Edit “iew Data

Transform

Analyze

Lt

T

EHE & 60 3 & B4 5

Rank_Sem!1 | Rank_Sem2|

war

oo N m | e =

[a)

aJ

c. Analyze > correlate > bivariate

)

1

LU i R s ) Lt N |

2

~ O o L ke =

File  Edt “iew Data  Iransform

HE B &0 nE |

Analyze Graphs  Uilties

Add-ons  WINdow

13

Rank_Ser? | Rank_§

f= IR = 3 RS TR

i~}

(=]

]

= |

m

@

-

(=]

=)

]
=]

i)

1

O W@ e m th = W R

Reports

Descriptive Statistics

Tahles

Compare Means

General Linear Model

Generalized Linest Models

Mized Models
Correlste
Regression
Loglinear

Meural Netwiorks
Classify

Data Reduction

Scale

Monparametric Tests

Time Series

Survival

EE Missing Yalue Analysis

Muttiple Response

Complex Samples

Quislity Contral
ROC Curye.

w 2%

B Bivariste..

Y2z Partial

& Distances...

d. Masukkan variabel yang akan dikorelasikan ke kolom Variable (s) - pilih
Correlation Coefficient Spearman-> pilih Two Tailed jika hipotesis tidak berarah

dan pilih One Tailed jika hipotesis berarah 2 klik OK
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“ariables: [
1l Rank_sem %l
di Rank_Sem2
-y
Correlation Coefficients
[prearson [ ] Kendsi's tau-b
Test of Significance
(%) Two-tailed () One-tailed
Flag significant correlstions
| QK J| Pazte || Reset || Cancel || Helg
e. Output.
Correlations
Rangking Rangking
semester 1 semester 2
Spearman's rho Rangking semester 1 Correlation Coefficient 1.000 _903’*\
Sig. (2-tailed) . .000 )
N 10 10
Rangking semester 2 Correlation Coefficient 903" 1.000
Sig. (2-tailed) 000 .
N 10 10

**. Correlation is significant at the 0.01 level (2-tailed).
Interpretasi:
Lihat Nonparametric Correlations > table correlations > Spearman’s Rho
Correlation menunjukkan koefisien korelasi antara dua variabel yang diteliti; sig.
(2-tailed) menunjukkan taraf signifikansi (=p).
¢ Hipotesis dinyatakan diterima jika p < 0,05 dan ditolak jika p > 0,05.
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PERTEMUAN 2

1. INDEPENDENT SAMPLE t-TEST (Statistik Parametrik)

Untuk menguji perbedaan pada 1 variabel tergantung (data: rasio/interval)
berdasarkan 1 variabel bebas (data: nominal) yang terdiri dari 2 kelompok subjek yang
berbeda.

Contoh hipotesis: ada perbedaan kemampuan pengambilan keputusan antara
remaja putra dan putri. Penelitian ini menunjukkan variabel tergantung adalah
kemampuan pengambilan keputusan, variabel bebas adalah jenis kelamin. Adapun
kelompok yang diteliti adalah remaja putra dan putri.

Sebelum data dianalisis menggunakan independent sample t-test terlebih
dahulu dilakukan uji asumsi yaitu uji normalitas dan uji homogenitas.

Berikut ini adalah data penelitian 4:
Variabel tergantung (X)  : Kemampuan pengambilan keputusan
Variabel Bebas (A) : Jenis kelamin

Tabel 5. Data Penelitian 4

No. A X
1 Putra 7
2 Putra 8
3 Putra 6
4 Putra 7
5 Putra 5
6 Putra 4
7 Putra 5
8 Putra 4
9 Putra 3
10 Putra 6
11 Putra 7
12 Putra 6
13 Putra 5
14 Putra 4
15 Putra 6
16 Putra 7
17 Putra 8
18 Putra 6
19 Putra 7

20 Putra 8
21 Putri 7
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No. A X
22 Putri 6
23 Putri 5
24 Putri 5
25 Putri 4
26 Putri 4
27 Putri 5
28 Putri 4
29 Putri 4
30 Putri 6
31 Putri 5
32 Putri 6
33 Putri 4
34 Putri 5
35 Putri 6
36 Putri 4
37 Putri 5
38 Putri 4
39 Putri 5
40 Putri 4

Langkah Analisis Independent Sample t-test:

1.

Masukkan keterangan variabel penelitian pada variabel view SPSS.
- Cantumkan nama variabel bebas pada kolom Name,

- Pada kolom Values (di dalam sel tercantum none) - klik none - klik kotak
abu-abu = muncul kotak value labels > Value: ketik kode angka

Value Label: ketik kelompok subjek sesuai kode angka yang diberikan - klik Add

Contoh: variabel bebas = jenis kelamin

Value = 1 Value = 2

Value Label = Putra Value Label = Putri

- Pada kolom measure untuk variabel bebas pilih nominal dan untuk variabel
tergantung pilih scale.
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Eile  Edit “jew Data Transform Anaslyze Graphs  Ulties  Add-ons Window  Help

cHE B b 3F & I8 S4E Y00
| Marme | Type | Width | DEEImE|S| Label | Yalues | Missing Columns Align I IMeasure |
X1 Mumeric g8 ] Jenis Kelamin {1, Putra} MNone g = Right &5 Mominal — ~
Y Mumeric g 0 Kemampuan Mone Maone i) = Right & Scale

R I W (S VO T

2. Masukkan data penelitian pada data view SPSS

File Ecit “iew Data Transform  Analyze Graphs  Uilities .

EHE b o0 LEE A Hd BEXRE

4130 |
| 1 | i | war ‘ war
1 1 7
2 1 g
El 1 5
4 1 7
& 1 g
B 1 4
7 1 L3
8 1 4
gl 1 3
10 1 5
11 1 7
12 1 5}
13 1 g
14 1 4
15 1 5
16 1 7
17 1 g
4]

Data View | Varisbie View |

3. Lakukan analisis uji asumsi dan uji normalitas sesuai langkah-langkah berikut ini.
Uji Normalitas: Klik Analyze > Nonparametric Tests - 1-Sample K-S, akan

muncul tampilan seperti ini:

Bl Ed View Dota Jranstorm | Analyze Grophs Mites Addgns  Window  Help

CHE B 00 LR A B2 e
31 - jenis kelamin 2 Descriptive Statistcs » - §
_[Jams kelamin _k.ambil Totdes Y | Bf One-Sample Kolmogorov-Smirmov Test ﬂ
1 1 Compare Means »
2| 1 Smmarel Lnesr Mol % Test Varishle List
3 1 Generalzed Lincar Models  » L - =
G 1 Miged Modeis L2 Options...
s 1 Correlate »
6 1 Regression »
7 1 Loginear »
8 1 Neural Networks »
g 1 Classity »
10 1 Data Reduction »
1 1 Scye »
T 12 1 Nocparametric Tests » (Tf Chi-Square e
13 1 Time Sevies ’ “R Ginomial Test Distribution
14 1 Survival » |58 guns Mormal [ | Uniform
_ 5 | 1 M e Artake ‘@ e D Poiz=on D Exponential
16 1 Mutiple Response » | 2independent Samples
17 1 Complex Samples » | M K independert Samples.
ia' 1 Guaity Control ’EWZW«!W | OK || Pazte H Reset H Cancel ” Help ]
19 1 7] Roc curye. | 8 K Relatea Samples
20 1 8
2 2 7
| 2 6
23| 2 5
24 2 5
% . 2 4
<]

Data View  Variable View

Pindahkan “k.ambik.kep” dari kolom kiri ke kanan, dengan cara klik “k.ambik.kep”
lalu klik tanda "anak panah ke arah kanan”, sehingga muncul seperti berikut:
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File Edt ‘iew Data Transform  Analyze  Graphs  UWilties  Adc-ons  Wincdow  Help
cHa B o0 LEBR A Ad E0F %29

31 1 jenis kelamin 2

jenis kelamin| k.amhil.kep | var | war | war | war war var var var var
1 1 7
2 1 8
3 1 5
; 1 ; E Cne-Sample Kolmogorov-Smirnov Test
5] 1 4 Test Yariable List:
7 i 5 & eris leelamin [ kambi kep ‘ —
L&} 1 4 =
9 1 3 N
10 1 B ‘*|
11 1 7 -
12 1 5
13 1 5
14 1 4 Test Distribution
15 ! B D Uniform
16 1 7 " .
o ] 3 [IPoissan [ Exponertial
18 1 B I\ o || easte |[ Ewet || cancel || Hem
19 1 7
20 1 8

Klik Options > beri tanda centang (1} pada descriptive, klik continue.

Pastikan bahwa kotak disamping tulisan Normal sudah di “klik” sehingga muncul
tanda (. Klik OK, lalu akan muncul hasil sebagai berikut:

" NPar Tests

[DataZetO]

One-Sample Kolmogorov-Smirnov Test

k.amhbil kep
I 40
Moarmal Parametars? Mean 547
Std. Deviation 1.318
Most Extreme Differences  Absolute ATE
Positive 76

Megative -
kaolmogarow-Smirnoy £ 1.116
Asyimp. Sig. (2-tailed) U166

S

a. Test distribution is Mormal.

Cara membaca hasil uji normalitas :

Asymp.Sig (taraf signifikansi/p) > 0,05: Distribusi data, normal

Asymp.Sig (taraf signifikansi/p) < 0,05: Distribusi data, tidak normal

Uji Homogenitas : Klik Analyze - Compare Means -> One-Way ANOVA, akan
muncul tampilan seperti ini:
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Eile Edt Vew Data Transform

Analyze | Graphs  Uiitles  Addons  Window  Help

EHE | 6o

L

31 - jenis kelamin [2

1

jenis kelamin|_k.ambi

e

Reports »

Deserigtive Statistics

Tables

M weans. ..
1 One-Sample T Test

Compare heans

J Linear Madel

Genetalized Linear Models Independent-Samples T Test

Wi Models: Prired-Samples T Test

Correlate: One-ay ANOWA

Regression
Loglinear

Meursl Networks
Classity

Dsta Reduction
Scale

Monparametric Tests

Time Series

Survival
Missing Valus Anslysis.
Multiple Response »
Complex Samples »
Guality Control b
ROC Curve...

a8

IJ var

-
B One-Way ANOVA

Dependert List:

&k ambil kep

% jeniz kelamin

Contrasts...
Post Hoc...

Options...

1)

Eactor:

OK

|| Paste H Reset ” Cancel ” Help I

Pindahkan "k.ambil kep” pada kotak dependent list dengan cara klik "k.ambil.kep”
lalu klik anak panah di samping kotak dependent list".

Pindahkan “jenis kelamin” pada kotak factor dengan cara klik “k.ambil.kep”lalu klik
anak panah di samping kotak factor”, sehingga akan muncul tampilan sebagai

berikut:

-
EH One-Way ANOVA

==

[+]

Dependent List:

| & ambil kep

|

Factar:

Paost Hoc...
Options...

R) jeniz kelamin

|| Paste || Besst || concel || hew |

Klik option, klik homogenity of variance test, Klik continue, klik OK

,
E One-Way ANOVA: Options

]

—————1| _statisti
B8 One-Way ANJ fsties

|:| Descriptive
[ Fixed snd randaom effects

ijomogeneity of variance tes‘t| I

[ wielch

|:| Erowwn-Forsythe

|:| Means plot

~Missing Values

@ Exclude cases analysiz by analysis

O Exclude cases listwise

[ Cortire ” Cancel ” Help
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Output yang akan muncul sebagai berikut:
Oneway

[Data3etO]

Test of Homogeneity of Variances

_kambilken Ve
Levene
Statistic df1 df? Sigg.
3912 1 38 085
ANOWA
~ambilken
Sum of
Squares dr IMean Sguare F Sig.
Between Groups 11.025 1 11.025 T.382 .01
Within Groups 56.750 38 1.483
Total 67775 39

Cara membaca Uji Homogenitas:

sig. (p) > 0,05: Data homogen
sig. (p) < 0,05: Data tidak homogen

Tuliskan hasil uji asumsi sebagai berikut:

Uji Asumsi Indeks p Keterangan
Normalitas K-SZ =
Homogenitas Levene Statistic =

4. Jika data memiliki distribusi normal dan homogen, maka analisis independent
sample t-test dapat dilakukan.
5. Klik Analyze > Compare Mean - Independent Sample t-test

File Edit Wiew Data TIransform | Analyze  Graphs  Utities  Acdd-ons  window  Help
=EH & m fm B Regorts ’ § @
41 ;¥ Descriptive Statistics 3
- v|  Tames » . . .
1 1 Compare Means ] M Means... I
2 1 General Linear Model |t One-Sample T Test...
3 1 Generaliiged Linear Models  # | &% Indlependent-Samples T Test...
4 1 Mixed Models L3 n,?ni Paired-Samples T Test...
5 " Correlate | B Onetniay ANOVA...
B 1 Regression (]
7 1 Loglineat 13
a 1 Meural Metworks 3
g 1 Classify 3

6. Masukkan nama variabel tergantung pada kolom Test Variable(s) dan data
variabel bebas masuk pada kolom Grouping Variable.
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Elndependent-SamplesTTest @ Lot 3 s Sl e |

E Define Groups @

Test Yariable(sT
ﬁ Kematmpuan ']

| Cptions... |
() lse snecitisd valuss
- oo 1

1) Grouping Variable: '::-::' Cut paint:
‘4" 107 _
| Define Groups | | Continue || Cancel || Help
A ——
| Reset || Cancel || Help |

7. Kemudian klik define groups - group 1 & group 2, masukkan angka sesuai kode
value label yang digunakan. Klik continue kemudian klik OK.
8. Lihat hasil (output)

T-Test
[Datalet0]
Group Statistics
Jenis Std. Error
Ke il Mean Stol. Deviation Mean
Kemampuan  Putra 20 5.95 1.468 318
Futri 20 4.90 912 204

Independent Samples Test

Levene's Test for Eguality of

wariances ttest ior Equality of Means
95% Confidence
Differe
Mean Std. Error
F Sig. T of Sig. (3-tailed; Difference Difference Lowyer
Kemampuan  Egualvariances
Fesumad 3.812 055 2717 a8 010 1.050 306 268
Equal variances not
itk 2717 | 3762 011 1.050 386 263

9. Interpretasi

Lihat tabel Independent Sample Test > equal variance assumed

e Kolom t menunjukkan indeks perbedaan

e Kolom sig. (2-tailed) menunjukkan taraf signifikansi (p).

e Hipotesis dinyatakan diterima jika p <0,05 dan dinyatakan ditolak jika
p>0,05.

o Jika hipotesis diterima, untuk melihat kelompok yang memiliki skor yang
lebih tinggi, lihat tabel group statistics pada kolom mean.
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2. PAIRED SAMPLE t-TEST (Statistik Parametrik)

Untuk menguji perbedaan pada 1 variabel tergantung (data: rasio/interval)
yang disebabkan oleh 1 variabel bebas (berupa perlakuan). Data berasal dari 1

kelompok subjek.

Penelitian yang biasa menggunakan analisis statistik paired sample t-test adalah

penelitian eksperimental.

Contoh hipotesis: ada pengaruh pelatihan empati untuk menurunkan
agresivitas pada remaja. Pengaruh dijelaskan dari adanya perbedaan tingkat
agresivitas antara sebelum (pretest) dan setelah (posttest) mengikuti pelatihan empati.
Penelitian ini menunjukkan variabel tergantung adalah agresivitas, variabel bebas
(perlakuan) adalah pelatihan empati, kelompok yang diteliti adalah remaja.

Suatu data dapat dianalisis dengan menggunakan paired sample t-test jika

memenuhi uji asumsi normalitas.
Berikut ini adalah data penelitian 5:

Variabel tergantung (X) : Agresivitas
Variabel bebas (A) : Pelatihan Empati
Tabel 6. Data Penelitian 5
Agresivitas
No. Pretest Posttest
1 12 9
2 8 6
3 13 10
4 9 9
5 9 8
6 9 7
7 7 6
8 6 5
9 8 7
10 9 8
11 9 9
12 13 11
13 13 12
14 16 14
15 17 15
16 14 12
17 15 13
18 17 14
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Agresivitas

No. Pretest Posttest
19 18 15
20 9 7
21 8 8
22 8 6
23 7 5
24 8 7
25 10 8
26 13 9
27 14 11
28 12 10
29 11 9
30 13 10
31 14 12
32 14 11
33 11

34

35

Langkah Analisis Paired Sample t-test:
a. Klik variable view (kiri bawah, sebelah kanan data view) = beri nama variabel

sesuai dengan variabel penelitian.

File  Edt ‘“iew Data Transform  Anslyze  Graphs  Utities  Add-ons  Window  Help

cHE T o0 LERF & Mt S6FE %00

| Marne | Type | Width | Decirmals Label | Walues Mlissing Caolurmns Align ‘ Measure
1 pre MNumeric 3 u} Mone MNone &} = Right & Seale
2 post MNumeric a EE Mone Mone g = Right & Scale

i

b. Masukkan data penelitian di data view.

Ele  Edt Yiew Data Transform  Analyze Graphs  Utities  Addons Wi

CHE T o0 LEF A Nl E0H 300

1:pre 12
T m = e o o
1 12| 9
2 8 B
3 13 10
4 E] 9
5 E] 8
B E] 7
7 7 B
8 B 5
9 8 7
10 E] 8
11 E] 9
12 13 "
13 13 12
14 16 14
15 17 15
16 14 12
17 15 13
LN |
T e
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¢. Lakukan uji normalitas pada data pre dan post
d. Lakukan analisis paired sample t-test. Klik Analyze > Compare Mean - Paired

Znalyze  Graphs Uiities Add-ons  Window  Help

Sample t-test

File Ecit iew Data Iransform
CHDE E 00 mw

1:pre 12
pre po

1 12

2 g

El 13

4 9

5 9

B 9

7 7

g 6

9 g

10 9

11 9

12 13

e. Pindahkan sepasang data masuk ke kotak : Paired variables - klik OK

E Paired-5amples T Test

Reports »
Dgscriptive Statistics
Tables

Compare Means

General Linear Model
Generalized Linear Madels
Mized Models

Correlate

Regression

Loglinear

Meural Netyorks

Classify

Data Reduction

Scale

Yy Y Y YT YTYTYTYYYTYTYTTTY

Monparametric Tests

Paired Variables:

@

M eans...

t COne-Sample T Test...

& Independent-Samples T Test...
o%, Paired-Samples T Test...

F One-iay ANOVA..

o

=X

& pre Pait ariablel wariahle2 |Qphi|
& post 1 [pre] [post]
2
’
k2 ¥
| Ok || Paste || Reset || Cancel || Help
f. Lihat hasil output SPSS
Paired Samples Test
Paired Differences
95% Caonfidence Interval of the
Difference
hiean Std. Deviation Str?ﬂ'egrr:m Lower Lpper i A df m
Fair1  pre- post 1614 351 61 1,588 2241 11.910 J 34 000
N— S
g. Interpretasi
Lihat tabel Paired Sample t-test:
e Kolom t menunjukkan indeks perbedaan

e Kolom sig. (2-tailed) menunjukkan taraf signifikansi (p).
¢ Hipotesis dinyatakan diterima jika p <0.05 dan dinyatakan ditolak jika p

>0.05
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PERTEMUAN 3

1. MANN WHITNEY U-TEST (Statistik Non Parametrik)

Untuk menguji perbedaan pada 1 variabel tergantung (data: rasio/interval)
berdasarkan 1 variabel bebas (data: nominal) yang terdiri dari dua kelompok subjek
yang berbeda.

e Teknik analisis ini dipakai jika jumlah subjek (n of sample) sedikit dan/atau
sebaran data tidak normal

Contoh hipotesis: ada perbedaan kematangan karir antara siswa laki-laki dan
siswa perempuan. Penelitian ini menunjukkan variabel tergantung adalah
kematangan karir, variabel bebas adalah jenis kelamin, kelompok yang diteliti adalah
siswa laki-laki dan perempuan. Berikut ini merupakan data penelitian 6 :

Variabel tergantung (X) : Kematangan Karir
Variabel bebas (A) : Jenis Kelamin

Tabel 7. Data Penelitian 6

No A X
1 Laki-laki 25
2 Laki-laki 83
3 Laki-laki 81
4 Laki-laki 88
5 Laki-laki 86
6 Laki-laki 89
7 Laki-laki 90
8 Laki-laki 85
9 Laki-laki 86
10 Laki-laki 85
11 Perempuan 35
12 Perempuan 99
13 Perempuan 94
14 Perempuan 96
15 Perempuan 92
16 Perempuan 99
17 Perempuan 97
18 Perempuan 94
19 Perempuan 93
20 Perempuan 97
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Langkah Analisis Mann Whitney U-test:
a. Masukkan keterangan variabel penelitian pada variabel view SPSS.

- Cantumkan nama variabel bebas pada kolom Name,

- Pada kolom Values (di dalam sel tercantum none) - klik none - klik kotak
abu-abu 2 muncul kotak value labels > Value: ketik kode angka

Value Label: ketik kelompok subjek sesuai kode angka yang diberikan - klik Add

Contoh: variabel bebas = jenis kelamin

Value = 1 Value = 2

Value Label = Putra Value Label = Putri

Pada kolom measure untuk variabel bebas pilih nominal dan untuk variabel
tergantung pilih scale.

File Edit Yiew Data Transform Analyze Graphs  Uiltiss  Addons Window  Help
EHE E o0 = A id BEE S0
‘ Mame ‘ Type ‘ Width |De:ima\s| Lakel ‘ Walues Missing Columns Align | Measure
1 JK Murneric g 0 Jenis Kelamin aki-laki}. 7|Nune = Right &b Mominal
2 Kermat_karir - Murmeric 8 u] Kernatangan Karir None Mone = Right & Scale
E
4
5
B
= FB] value Labels ==
g Value Labels
— T — (o]
1 s | \
12 [ = "Laki-laki"
13 2 = "Perempuan’
14
15
16
17
18 ‘ aK | cancel H Help
19
20

b. Masukkan data penelitian pada data view.

EA “Untitledl [DataSet0] - SPSS Data Editor T

File: Edit pa = Data Transtorm Analyze Graphs

EH&S W o =EE M4 Ed

10K 1

| k< Kemat_Karir| war
1 1 25
2 1 a3
3 1 g1
4 1 5151
5 1 &3]
=] 1 a9
7 1 j=lu}
g 1 [=tal
g 1 g6
10 1 [
1 2 35
12 2 99
13 2 4
14 2 96
15 2 92
16 2 93
17 2 97
18 2 94
12 2 93
20 2 97
21

c. Lakukan uji homogenitas untuk data tersebut.

41



Panduan Praktikum Statistika Dasar
Fakultas Psikologi UAD

d. Setelah data dinyatakan homogen, lanjutkan proses analisis
Klik Analyze > Nonparametric Tests > 2 Independent Samples

e. Masukkan variabel tergantung ke kolom Test Variable(s) dan data variabel bebas
ke kolom Grouping Variable. Kemudian klik define groups -> group 1 & group
2, masukkan angka sesuai kode values label yang digunakan. Klik continue
kemudian klik OK.

Data  Transform

Analyze  Graphs

Uiities ~ Add-ons  Window  Help

be LE|

JK Kemat |

T R S I S R

Regorts
Descriptive Steistics
Tables
Compare Means
General Linear hade!
Generalized Lingar Models
Wiged Models
Correlate
Regression
Logfinear
Neural Netwarks
Classify
Data Recuction
Segle
Honperametric Tests
Time Series
Survival

Missing Velue Snalysis
Mutpls Response
Complex Samples
Qualty Confrol
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f. Lihat output SPSS.

g. Interpretasi:
Lihat hasil Non Parametric Test (Npar Test) - Mann Whitney U > Test

Statistics.
= Skor Mann Whitney U menunjukkan indeks perbedaan.
» Kolom sig. (2-tailed) menunjukkan taraf signifikansi (p) untuk hipotesis yang

tidak berarah.

» Exact sig. (1-tailed) digunakan untuk hipotesis berarah.
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a. Mot corrected far ties.
b. Grouping Wariable: Jk

Hipotesis dinyatakan diterima jika p < 0,05 dan dinyatakan ditolak jika p > 0,05.

Jika hipotesis diterima, untuk mengetahui kelompok yang memiliki nilai lebih

tinggi dengan cara membandingkan Mean Rank antar kelompok.
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contoh hipotesis tidak berarah (two tailed): "ada perbedaan kematangan karir
ditinjau dari jenis kelamin"
indeks perbedaan Mann Whitney U = 9,0 dengan p = 0,002 (p < 0,01),
kesimpulan: hipotesis diterima, yaitu ada perbedaan kematangan karir antara
siswa laki-laki dan perempuan.
contoh hipotesis berarah (one tailed): "ada perbedaan kematangan karir antara
siswa laki-laki dan perempuan, siswa perempuan memiliki kematangan karir yang
lebih tinggi daripada siswa laki-laki"
indeks perbedaan Mann Whitney U = 9,0 dengan nilai p = 0,001 (p < 0,01)
kesimpulan: hipotesis diterima, yaitu ada perbedaan perbedaan kematangan
karir antara siswa laki-laki dan perempuan, siswa perempuan memiliki
kematangan karir yang lebih tinggi daripada siswa laki-laki.

2. WILCOXON (Statistik Non Parametrik)
Untuk menguji perbedaan pada 1 variabel tergantung (data: rasio/interval)
yang disebabkan oleh 1 variabel bebas (berupa perlakuan). Data berasal dari 1
kelompok subjek.

Penelitian yang biasa menggunakan analisis statistik wilcoxon adalah penelitian
eksperimental.

Contoh hipotesis: “ada pengaruh pelatihan kebersyukuran untuk meningkatkan
kebermaknaan hidup pada lansia penghuni panti jompo.”

Pengaruh dijelaskan dari adanya perbedaan tingkat kebermaknaan hidup antara
sebelum (pretest) dan setelah (posttest) mengikuti pelatihan kebersyukuran.

Pada penelitian ini, variabel tergantung adalah kebermaknaan hidup, variabel
bebas adalah pelatihan kebersyukuran, kelompok yang diteliti adalah lansia yang
tinggal di panti jompo. Berikut ini merupakan data penelitian 7:

Variabel Tergantung (X)  : Kebermaknaan Hidup
Variabel Bebas (A) : Pelatihan Kebersyukuran

Tabel 8. Data Penelitian 7

Kebermaknaan Hidup
No

Pretest Posttest
1 32 50
2 67 74
3 72 75
4 71 74
5 67 74
6 62 70
7 69 72
8 69 73
9 72 74
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10 32 34

11 73 76

12 74 77

13 71 76

14 71 74

15 73 78

Langkah Analisis Wilcoxon:

1.

Klik variable view - beri nama variabel sesuai dengan variabel penelitian.

File Ecit Wiew Data Transform  Analyze Graphs  Utities  Add-ons  Window  Help

cHdE @ o0 B 4 dd SEA %o %]

[ mMame [ Type | width | Decimals | Label [ wvalues Missing | Colurnns Align | Measure
1 pre Mumeric =] a pre kebermaknaan MNone Mone =] Right & Scale
2 post Mumeric =] a post kebermaknaan None Mone g = Right ‘&’ Scale =

_ 3 |

Masukkan data penelitian ke data view.

[l “Untitied1 [DataSet0] - SPSS Data Editor
fie Edt \iew Dala  Transform  Anclyze Graphs Lkt
=HE B 00 =EHik & B3 5
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pretest | posttest | var |

1 2 50
2 &7 74
3 72 75
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& 62 70
7 69 72
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10 2 3
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12 74 77
13 7 76
14 ki 74
15 73 78
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3. Klik Analyze > Non parametric Tests -> 2 Related Samples.
4. Klik sepasang data masuk ke kotak: Test Pair(s) > Klik OK
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==
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7 Regression »
i) Losinesr > Test Pairs:
B R — N ¢ pre kebermaknaan [pre] Pair | Weriablel | Weriable2 +
T sty . & post kebermaknaan [post] —~ ; pre kebe: post ke
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12 Scale » Nt
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5. Lihat hasil Output SPSS

Wilcoxon Signed Ranks

Ranks
I Mean Rank | Sum of Banks
posttest- pretest  Megative Ranks 0= oo oo
FPositive Ranks 158 8.00 120.00
Ties o=
Total 15

a. postiest = pretest
h. postiest = pretest
r. postiest = pretest

Test Statistics®
— — ——

posttest-

pretest
z -3.4343
L Asymp. Sin. (2-tailed) 001

a. Based on negatve ranks.
h.Wilcoxon Signed Ranks Test

6. Interpretasi:

Lihat hasil Wilcoxon Signed Rank Test - lihat tabel Test Statistics.

= Skor Z menunjukkan indeks perbedaan

= Kolom sig. (2-tailed) menunjukkan taraf signifikansi (p).

» Hipotesis dinyatakan diterima jika p < 0,05 dan dinyatakan ditolak jika p > 0,05.

= Jika hipotesis diterima untuk mengetahui kelompok yang memiliki nilai lebih
tinggi dapat dilihat langsung dari nilai positif atau negatif dari skor Z.

“ada pengaruh

Pada kasus di atas, hipotesis yang diajukan adalah

kebersyukuran untuk meningkatkan kebermaknaan hidup lansia penghuni panti
jompo”, maka berdasarkan skor Z = -3,434 dengan nilai p = 0,001 (p < 0,01) dapat
disimpulkan bahwa hipotesis diterima, yaitu ada perbedaan kebermaknaan hidup
antara sebelum (pre) dan setelah (post) mengikuti pelatihan kebersyukuran pada
lansia penghuni panti jompo, setelah mengikuti pelatihan kebersyukuran

kebermaknaan hidup lansia penghuni panti jompo meningkat.

Hasil ini menunjukkan:

- ada pengaruh pelatihan kebersyukuran untuk meningkatkan kebermaknaan

hidup lansia penghuni panti jompo.

- pelatihan kebersyukuran efektif untuk meningkatkan kebermaknaan hidup

lansia penghuni panti jompo.




